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• Understand word processing 

software 

• Explore the Word program window 

• Start a document 

• Save a document 

 

Objectives 
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• Select text 

• Format text using the Mini toolbar 

• Create a document using a template 

• View and navigate a document 

 

Objectives (continued) 
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• Microsoft Word is a word processing 
program used to create: 
• Letters 

• Memos 

• Newsletters 

• Research papers 

• Web pages 

• Business cards 

• Resumes 

• Financial reports 

• Other types of documents 

Unit Introduction 
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Understanding Word  

Processing Software 
• A word processing program is software 

that allows you to enter, edit, and format 

text and graphics 

• Copy and move text 

• Format text with fonts and color 

• Format and design page layout 

• Insert tables, charts, diagrams, and graphics 

• Use mail merge to create form letters 

• Share documents securely 

• The files you create using Word are called 

documents 
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Understanding Word  

Processing Software (continued) 

Formatted 

text 

Graphic 

Table 

Chart 

Column 

Header 
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Understanding Word  

Processing Software (continued) 

• Plan a document before you create it 

• Identify: 

• Message 

• Audience 

• Elements to include (charts, tables, etc.) 

• Appropriate tone and look for the 

document (formal, playful, etc.) 

• The purpose of and audience for a 

document determine its design 
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Exploring the Word Program 

Window 

• The Word 

program window 

opens and 

displays a blank 

document in 

Print Layout view 

• The insertion 

point indicates 

where text 

appears when 

you type 

Blank 

document 

I-beam pointer 

Insertion point 
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Exploring the Word Program 

Window (continued) 

• The mouse pointer changes shape 
depending on its location in the 
Word program window 

• Each pointer is used for a different 
purpose 

• Click and type pointers position the 
insertion point and apply paragraph 
formatting 

• A ScreenTip appears when you 
point to a button or element in the 
Word program window 
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Exploring the Word Program 

Window (continued) 

Document 

window 

Ribbon 

Title 

bar 

Scroll 

bar 
Ruler 

Status 

bar 

Quick 

Access 

toolbar 

View 

buttons 
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Exploring the Word Program 

Window (continued) 

• The Ribbon contains tabs 

• Tabs include buttons for commands related to 

editing and formatting documents 

• Commands are organized in groups 

• Quick Access toolbar contains frequently 

used commands and is customizable 
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Exploring the Word Program 

Window (continued) 

• The Word program window 

• Title bar displays the program and 
document names 

• File tab provides access to Backstage 
view, which contains commands related 
to managing and sharing documents: 
• Create, open, save, and print a document 

• Share a document 

• Access Word Options dialog box 

• Microsoft Office Help button provides 
access to the Word Help system 
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Exploring the Word Program 

Window (continued) 

• The Word program window (cont.) 

• Document window displays the 

current document 

• Rulers show margin, tab, and indent 

settings 

• Scroll bars are used to display different 

parts of the document in the document 

window 
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Exploring the Word Program 

Window (continued) 

• The Word program window (cont.) 

• Status bar shows page information, the 

location of the insertion point, and the 

on/off status of several Word features 

• Status bar includes: 

• View buttons 

• Zoom level button and Zoom slider 
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Starting a Document 
• Begin a new document by typing in a blank 

document in the document window 

• Word includes a word-wrap feature 

• As you type, the insertion point moves automatically to 

the next line when you reach the right margin 

• Press [Enter] only when you want to start a new 

paragraph or insert a blank line 

Wrapped text 
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Starting a Document (continued) 

• Insert text in a document by clicking 
to move the insertion point and then 
typing 

• Press [Tab] to indent text 

• Delete text 

• Press [Backspace] to delete the text 
before the insertion point 

• Press [Delete] to delete the text after 
the insertion point 
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Starting a Document (continued) 

• Automatic features that might appear as 

you type: 

• AutoComplete 

• AutoCorrect 

• Spelling and Grammar 
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Saving a Document 

• To store a document permanently, you 

must save it as a file 

• When you save a file you give it a name, 

called a filename, and indicate the location 

to store the file 

• A filename identifies the file  

• Files can be stored on an internal hard disk, 

on a CD or jump drive, or in another location 

• Saving a file allows you to close the file 

and open it later for editing or printing 
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Saving a Document (continued) 

• Save a file for the first time using the Save button 
on the Quick Access toolbar or the Save 
command on the File tab 

• Assign a filename and a file location to a 
document using the Save As dialog box 
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Saving a Document (continued) 

• After you save a file for the first time, 

save frequently as you work  

• Saving updates the stored copy of the 

file with your changes 

• Save changes using the Save button,  

the Save command, or [Ctrl][S] 

• Store files on your SkyDrive so you 

and your colleagues can access and 

edit documents online 
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Selecting Text 

• You must select text before deleting, 

editing, or formatting it 

• Click and drag the I-beam pointer 

across text to select it 

• Selected text is highlighted 
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Selecting Text (continued) 

Selected text 
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Selecting Text (continued) 

• Formatting marks are special characters 

that appear on screen to help you edit and 

format text 
This formatting mark 

indicates a blank 

line or the  

end of a paragraph 

• Formatting marks do 

not print 

• Use the Show/Hide ¶ 

button to turn the 

display of formatting 

marks off and on 
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Selecting Text (continued) 

Methods for selecting text 

• To select text quickly, learn to use the 

mouse to select words, lines, paragraphs, 

and other large blocks of text 
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Formatting Text Using the Mini 

Toolbar  

• Includes the most commonly used text 

and paragraph formatting commands 

• Appears faintly above selected text 

• Becomes solid when you point to it 

• Right-click selected text if the Mini toolbar 

disappears 
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Formatting Text Using the Mini 

Toolbar (continued) 

• Printing a document – before printing a 

document, examine it for errors in 

Backstage view 
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Formatting Text Using the Mini 

Toolbar (continued) 

• The Print tab in Backstage view shows a 

preview of how the document will look 

when printed 

• Enlarge the view of the document to see 

details 

• Reduce the view to see the overall layout  

• Press [Esc] or click the Home tab to close 

Backstage view and correct any mistakes 

• Click the File tab to open Backstage view, 

then click Print to open the Print tab 
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Formatting Text Using the Mini 

Toolbar (continued) 

• Print a document after proofing a 

document and correcting errors 

• Use the Print tab in Backstage view to change 

the print settings before printing 

• Number of copies 

• Page range 

• Default printer 

• Click the Print button on the Print tab when 

you are ready to print the document 
 

 
Microsoft Office Word 2010 - Illustrated Complete 



29 

Formatting Text Using the Mini 

Toolbar (continued) 

• Print a document (con’t) 

• The Quick Access toolbar can be customized 

to include the Quick Print button 

• Click the Quick Print button to print the document 

using the default print settings 

• Prints a single copy of the entire document 
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Creating a Document Using a 

Template 

• A template helps you create a 
formatted document quickly 

• A template is a formatted document 
that contains placeholder text 

• You replace the placeholder text with 
your own text and save the file with a 
new filename 

• Word includes templates for faxes, 
letters, reports, brochures, and other 
types of documents 
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Creating a Document Using a 

Template (continued) 

• New tab in Backstage view 
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Templates 

Preview 
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Creating a Document Using a 

Template (continued) 

• Replace placeholder text with your 

information 

 

Inserted 

text Placeholder 

text 
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• Using the Undo, Redo, and Repeat 

commands 

• Reverse the last action with the Undo 

button 

• Restore a change that you reversed 

with the Redo button 

• Repeat a change with the Repeat 

command on the Edit menu 

Creating a Document Using a 

Template (continued) 
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• Zoom feature 

• Enlarge document for a close-up view 

• Reduce document for an overview of 
the layout 

• Use tools in the Zoom group on the 
View tab 

Viewing and Navigating a 

Document  
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• Use the Zoom level button on the 
status bar 

• Use the Zoom slider on the status 
bar 

 

Viewing and Navigating a 

Document (continued) 

Zoom level 

button 

Zoom 

slider 

Zoom In Zoom Out 
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• Scroll to display different parts of a 
document 

• Drag the scroll box up or down in the 
Vertical scroll bar 

• Drag the scroll box right or left in the 
Horizontal scroll bar 

• Click the Previous Page button 

• Click the Next Page button 

 

Viewing and Navigating a 

Document (continued) 
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Viewing and Navigating a 

Document (continued) 

• Word includes different views, or 
ways of displaying a document 

• Print Layout view displays a document 
as it will look on a printed page 

• Full Screen Reading view displays 
document so it is easy to read onscreen 
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Viewing and Navigating a 

Document (continued) 

• Word document views (cont.) 

• Web Layout view displays a document 

as it will look when viewed on a 

computer screen using a Web browser 

• Outline view displays the headings in a 

document in outline form 

• Draft view shows a simplified layout of 

a document, without margins, headers 

and footers, or graphics 
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• When you start Word, a blank 
document opens in the document 
window 

• To create a new document, begin 
typing in the blank document 

• Save the new document with a 
descriptive filename 

• As you edit the document, save your 
changes to it often 

Summary 
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Summary (continued) 

• Select text as you work 

• Format text using the Mini toolbar 

• Create documents based on 

templates 

• Use the Word Zoom feature to 

enlarge or reduce the size of a 

document 

• Display your document using 

different Word views 
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Summary 
 

• Preview a document in Backstage 

view before printing 

• Save, print, and then close the 

document 

• When you are finished editing and 

creating documents, close all open 

files, and then close Word 
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